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Preface 
Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 

Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-085940.html 
contains the latest versions of the Agile PLM PDF files. You can view or download these manuals 
from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation 
folder available on your network from which you can access the Agile PLM documentation (PDF) 
files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 9.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through Help 
> Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or 
information, please contact My Oracle Support (https://support.oracle.com) for assistance. 

Note Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 

Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-
085940.html. 

Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  

http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.adobe.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
https://support.oracle.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/education/chooser/selectcountry_new.html
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Chapter 1 

Installing and Configuring Agile Recipe and 
Material Workspace 

This chapter includes the following: 

 About Recipe and Material Workspace .......................................................................................................... 5 
 Obtaining Software ....................................................................................................................................... 5 
 Installing Agile RMW Prerequisites ................................................................................................................ 6 

 
 

About Recipe and Material Workspace 
Recipe and Material Workspace (RMW) helps to scale up the material production in an orderly and 
reproducible manner. It comprises elements that are people, material, equipment, processes, 
standards, analytical, recipe, organization, and environment. Elements in Recipe and Material 
Workspace are also referenced as business objects. 

Recipe and Material Workspace consists of nine components: 

 People 

 Material 

 Equipment 

 Process 

 Standards 

 Analytical 

 Recipe 

 Organization 

 Environment 
 

Obtaining Software 
Oracle products are distributed as Media Packs. A Media Pack is an electronic version of the 
software. Refer to the Media Pack description or the list of products that you purchased on your 
Oracle ordering document. Then, view the Quick Install Guide License List to help you decide which 
Product Pack you need to select in order to search for the appropriate Media Pack(s) to download. 
Prior to downloading, verify that the product you are looking for is in the License and Options 
section of the E-Pack Readme. Oracle recommends that you print the Readme for reference. 

Download the Oracle Agile Applications (Oracle Agile Product Lifecycle Management Release 9.3.2 
Media Pack)  Media Pack from the Oracle Software Delivery Cloud web site 
(http://edelivery.oracle.com). 

http://edelivery.oracle.com/
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There will be an itemized part list within each of the packs and you will need to download all items in 
order to have the complete download for the desired Oracle Agile release. 

All Oracle Software Delivery Cloud files have been archived using Info-ZIP's highly portable Zip 
utility. After downloading one or more of the archives, you will need the UnZip utility or the Winzip 
utility to extract the files. You must unzip the archive on the platform for which it was intended. 
Verify that the file size of your downloaded file matches the file size displayed on Oracle Software 
Delivery Cloud. Unzip each Zip file to its own temporary directory. 

Installing Agile RMW Prerequisites 
Before installing the Agile RMW application, the Agile PLM application and Agile RMW database 
must be installed and running. For information on how to set up the Oracle database before 
installing the Agile RMW database, see the Agile PLM Database Installation Guide. 

For the complete list of hardware and software requirements, see the Agile PLM Capacity Planning 
Guide. 
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Chapter 2 

Installing the Agile RMW Database on 
Windows 

This chapter includes the following: 

 Installation Notes .......................................................................................................................................... 7 
 Creating the Agile RMW Database on Windows............................................................................................. 7 

To install the Agile database on Windows: 

1. Within the installation folder, double-click the agilermw9320db_oracle.exe file to start the 
installation on Windows. The Agile Database Configuration Utility appears.  

2. Follow the instructions in Creating the Agile RMW Database on Windows on page 7 to 
configure the database. 

3. Complete the post-installation steps described in Post-Installation Tasks on page 15 

 
 

Installation Notes 
For best results, as you install: 

 Follow directions in the order in which they are given. Do not attempt to install any components 
out of sequence.    

 Oracle passwords and Agile passwords are case-sensitive. All other text entries, such as 
schema names and folder names, are not case-sensitive. To avoid confusion, all passwords 
and text entries in this guide appear in lowercase and should be typed as shown. 

 When prompted for a hostname, type the fully qualified name for the host, not the short name. 
For example, if a host is named dbo, type dbo.agile.com, not dbo. 

 

Creating the Agile RMW Database on Windows 
The Agile Database Configuration Utility creates and configures the database used by Agile. To 
start this utility, double-click the database installer executable file. 

Drop-down lists that allow disk selection show the available disk space. If the space is a negative 
value, you must select another drive. 

Important If you change a default value, you must click in the field to ensure that the change is 
activated. 

 

To configure the database: 

1. In the Destination Location dialog box of the Database Configuration Utility, accept the default 
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location, Agile9Tmp, or click Browse to specify a destination of your choice. This is the location 
where template files are placed during the database installation. Throughout this document, 
this location is referred to as Agile9Tmp. Click Next. 

2. In the Oracle Home dialog box, choose the appropriate ORACLE_HOME. This is the location 
where the Oracle software was installed. If you have multiple Oracle Homes, make sure the 
correct Oracle Home is selected in the list before continuing with the Database Configuration 
Utility. Click Next. 

3. In the Oracle SID dialog box, accept the default agile9 SID. If you want to change the SID, you 
must use an ID that is 4 to 8 characters in length to uniquely identify the Oracle SID. If you 
want to use an existing SID, you must remove it before you can re-use it. Click Next.  

Note If you only want to generate database scripts (for example, to upgrade an existing 
Agile schema), select the Generate database scripts only option. In this case, you 
should use an existing SID.  Follow onscreen directions to generate scripts. Note 
that Agile Recipe & Material Workspace database scripts may also be generated if 
you select this option.  

4. In the Database Security and Agile User Information dialog box, set the Internal/Sys password, 
SYSTEM password, CTXSYS password, Agile Schema Name, and Agile Schema Password. 
Each password must be at least 6 characters long. 

Click Next.  

5. In the Database Size Estimate dialog box, choose a database sizing model. New Agile 
customers without an existing database to migrate should accept the default (Small). Click Next. 

You can reselect a database sizing model depending on disk space available. 

Note Refer to the Capacity Planning Guide for database sizing information.  

6. The next dialog provides an option to create and configure the Agile Recipe & Material 
Workspace database schema. If you do not want to create the RMW database schema, skip 
this step and click Next.  

To create the RMW database schema, select the Create Recipe & Material Workspace schemas 
check box. Set the name and password for the RMW Owner Schema and the RMW User 
Schema. 

Click Next. 

Note Use the tables in the section "Disk I/O Configurations" in the Agile PLM Database 
Installation Guide for guidance while performing steps 7 through 10.     

7. In the Tablespaces dialog box, accept the default, unless you have additional hard drives with 
sufficient space available that allow you to distribute the files across multiple hard drives. If you 
change the selection to a different drive location, click the letter of the drive to make sure it is 
selected. Click Next. 

8. In the Redo Log Files and Control Files dialog boxes, accept the default, unless you have 
additional hard drives with sufficient space available that allow you to distribute the files across 
multiple hard drives. Click Next. 

9. If you accept the default location for the files on one drive, a message appears notifying you 
about distributing the files across multiple drives (mirroring protection). If this is not an option, 
click Next. Otherwise, click Back and reassign files to different hard drives. 
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10. In the Archive Log File dialog box, accept the default, unless you have additional hard drives 
with sufficient space available that allow you to store the file on a different hard drive. Click 
Next. 

11. In the Oracle Language Support dialog box, configure the  
parameter to determine datatype storage allocation by the database server. The default value 
is  Click Next  

12. Accept the default character set . Click Next. 

Note For additional information about language support, refer to the Oracle Globalization 
Support Guide. 

A Command Prompt window displays briefly. 

13. You are prompted to install the Agile database. Click Next. 

The script runs in a Command Prompt window for a while.  

14. When instance creation is complete, a confirmatory message appears. Click OK to complete the 
process and exit.  

Important Oracle recommends that you change all Oracle database user passwords after you 
have created the Agile database. It is recommended to change these passwords 
periodically for security purposes. 

Agile supports Full Text Search (FTS). FTS is a feature enabled through Oracle Text. Because of 
this feature, there is a fixed account, CTXSYS, referenced by some objects in the Agile schema. 
For security purposes, you can change the CTXSYS account password from its default, CTXSYS, 
to one of your own choice after Agile database creation and configuration. 
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Chapter 3 

Installing the Agile RMW Database on UNIX 

This chapter includes the following: 

 Preparing the Host Computer ........................................................................................................................ 11 
 Creating the Agile Database on UNIX ............................................................................................................ 12 
 Database Post-Installation Tasks .................................................................................................................. 15 

 
 

Preparing the Host Computer 
This section describes how to prepare the installation environment on UNIX.      

Preparation of the installation environment involves copying the Agile database utilities. 

To copy the Agile database utilities:   

1. Log in as the user that was used to install the Oracle database software and create a 
temporary directory named “agile9320db:” 

$ mkdir /home/oracle/agile9320db [Enter] 

2. Download the appropriate Agile PLM media pack for your operating system to the agile9320db 
directory. For more information on obtaining the media pack, see Obtaining Software from 
Oracle Support (for a Patchset/Minipack), or Obtaining Software from Oracle Software Delivery 
Cloud (for a major release). 

3. Change to the agile9320db directory, and extract the files from the agilermw9320db_oracle.tar.gz 
file: 

$ cd /home/oracle/agile9320db [Enter] 

$ gunzip -c agilermw9320db_oracle.tar.gz|tar xvf - [Enter] 

The agilermw9320db_oracle.tar file contains the following files: 

 agile9database.sh - shell script for creating the database instance and generating the 
database maintenance scripts 

 agile9schema.dmp — agile schema dump file 

 agilepharma.dmp— Agile RMW schema dump file 

 dbora — setup for the database automatic shutdown and startup 

 pdqplm_plsql.jar — Java stored procedures for the Enterprise Data Quality Product 
integration 

 profile.txt — oracle user .profile template 

 Readme.txt — readme file 

 system.txt — Solaris kernel parameters 
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Creating the Agile Database on UNIX 
This section describes how to set up Oracle environment variables and create the default database 
instance and schema used by Agile using the Agile database creation utility.       

To set up Oracle environment variables: 

1. Log in as the user that was used to install the Oracle database software. 

2. Create the environment parameter file .profile to include:  

PATH=$PATH:/usr/local/bin:/usr/ccs/bin:/usr/openwin/bin:/usr/bin/X11 

export PATH 

ORACLE_HOME=<Location where you installed Oracle Database Server> 

export ORACLE_HOME 

For example: 

(Oracle 11g)ORACLE_HOME=/u01/app/oracle/product/11.1.0/db_1; export ORACLE_HOME 

ORACLE_BASE=<Oracle base folder location>; export ORACLE_BASE 

For example: 

ORACLE_BASE=/u01/app/oracle; export ORACLE_BASE 

PATH=$PATH:$ORACLE_HOME/bin; export PATH 

ORACLE_SID=agile9; export ORACLE_SID 

NLS_LANG=AMERICAN_AMERICA.AL32UTF8; export NLS_LANG 

3. The environment variables settings above are stored in the file profile.txt included with the Agile 
database utilities. If this is the first time you are configuring the host computer as a database 
server, copy the profile.txt file to .profile: 

$ cat agile9320db/profile.txt > .profile [Enter]   

4. Set environment variables: 

$ . ./.profile [Enter] 

To start the installation:     

1. Log in to the computer as the user you created while preparing the installation environment. 
For example, Oracle. 

a. If necessary, edit the .profile file to change Oracle SID. By default, Agile uses agile9 as the 
Oracle SID:        

$ vi .profile [Enter]   

b. Modify the value where ORACLE_SID=agile9 by replacing agile9 with the SID you want to 
use. 
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Important Check the /var/opt/oracle/oratab file and make sure that the specified Oracle SID has 
not been used. Specifying an existing Oracle SID can corrupt that database instance. 

Note The recommended SID length is 4-8 alphanumeric characters. (The default SID 
'agile9' is six characters.)  

c. Source .profile to make the SID changes take effect: 

. ./.profile    [Enter]    

2. In a second terminal session, log in to the computer as the root user. 

3. Create a directory named “oradata.” 

Note The agile9database.sh file uses a placeholder mount point /mpt. You must change 
/mpt to match your mount points.  

For example, if you have mount points at /u01 and /u02, you can create an oradata folder on 
each mount point. 

# mkdir -p /u01/oradata 

# chown oracle:dba /u01/oradata 

4. In the session where you are logged in as the Oracle user, create a $ORACLE_BASE/admin 
directory: 

$ mkdir -p /u01/app/oracle/admin [Enter] 

(Assuming ORACLE_BASE is set to /u01/app/oracle.) 

chown -R oracle:dba /u01/app/oracle 

You must now run the agile9database.sh script. 

5. Change to the /home/oracle/agile9320db directory. 

6. Modify the agile9database.sh script to match the mount points on your computer. 

Note Make sure ORACLE_SID matches the one you set for .profile, which should have 
taken effect after you ran . ./.profile. 

Note The agile9database.sh file uses a placeholder mount point /mpt. You must change 
/mpt to match your mount points.  

The values in the script that can be modified appear in bold. You should limit your editing only 
to these bold values. 

Note The following code lists variables in bold that you may want to revise besides 
placeholder mount point /mpt. 

#!/bin/sh 

# 

# AGILE9DB_BASE is the base directory for the OFA directories and maintenance scripts 

# (create the directory before running this script) 

# (default is $ORACLE_BASE/admin/$ORACLE_SID) 
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# 

AGILE9DB_BASE=$ORACLE_BASE/admin/$ORACLE_SID 

# Parameters determine location of datafiles,  
# controlfiles and logfiles 

# 

DATABASE_SYSTEM=/mpt/oradata/${ORACLE_SID}              # SYSTEM tablespace mount 
point 

DATABASE_SYSAUX=/mpt/oradata/${ORACLE_SID}              # SYSAUX tablespace mount 
point 

DATABASE_TOOLS=/mpt/oradata/${ORACLE_SID}               # TOOLS tablespace mount point 

DATABASE_UNDO=/mpt/oradata/${ORACLE_SID}                # RBS tablespace mount point 

DATABASE_TEMP=/mpt/oradata/${ORACLE_SID}                # TEMP tablespace mount point 

DATABASE_USERS=/mpt/oradata/${ORACLE_SID}               # USERS tablespace mount 
point 

DATABASE_INDX=/mpt/oradata/${ORACLE_SID}                # INDX tablespace mount point 

DATABASE_AGILE_DATA1=/mpt/oradata/${ORACLE_SID}         # AGILE_DATA1 tablespace 
mount point 

DATABASE_AGILE_INDX1=/mpt/oradata/${ORACLE_SID}         # AGILE_INDX1 tablespace 
mount point 

DATABASE_AGILE_DATA2=/mpt/oradata/${ORACLE_SID}         # AGILE_DATA2 tablespace 
mount point 

DATABASE_AGILE_INDX2=/mpt/oradata/${ORACLE_SID}         # AGILE_INDX2 tablespace 
mount point 

DATABASE_AGILE_DATA3=/mpt/oradata/${ORACLE_SID}         # AGILE_DATA3 tablespace 
mount point 

DATABASE_AGILE_INDX3=/mpt/oradata/${ORACLE_SID}         # AGILE_INDX3 tablespace 
mount point 

DATABASE_AGILE_DATA4=/mpt/oradata/${ORACLE_SID}         # AGILE_DATA4 tablespace 
mount point 

DATABASE_AGILE_INDX4=/mpt/oradata/${ORACLE_SID}         # AGILE_INDX4 tablespace 
mount point 

DATABASE_AGILE_DATA5=/mpt/oradata/${ORACLE_SID}         # AGILE_DATA5 tablespace 
mount point 

DATABASE_AGILE_INDX5=/mpt/oradata/${ORACLE_SID}         # AGILE_INDX5 tablespace 
mount point 

DATABASE_LOGFILES1=/mpt/oradata/${ORACLE_SID}           # REDOLOG file 1 mount point 

DATABASE_LOGFILES2=/mpt/oradata/${ORACLE_SID}           # REDOLOG file 2 mount point 

DATABASE_LOGFILES3=/mpt/oradata/${ORACLE_SID}           # REDOLOG file 3 mount point 

DATABASE_LOGFILES4=/mpt/oradata/${ORACLE_SID}           # REDOLOG file 4 mount point 
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DATABASE_CONTROL1=/mpt/oradata/${ORACLE_SID}            # CONTROL file 1 mount point 

DATABASE_CONTROL2=/mpt/oradata/${ORACLE_SID}            # CONTROL file 2 mount point 

DATABASE_CONTROL3=/mpt/oradata/${ORACLE_SID}            # CONTROL file 3 mount point 

DATABASE_ARCHIVE=/mpt/oradata/${ORACLE_SID}/arch        # ARCHIVELOGS  

 

# Parameters determining: Character Set 

# 

CHARACTER_SET=AL32UTF8 

NATIONAL_CHARACTER_SET=AL16UTF16 

NLS_LANG=American_America.AL32UTF8 

# 

7. Run the agile9database.sh script from the current directory: 

$ ./agile9database.sh [Enter] 

8. You are prompted about the database size that you want to install. 

You should use the regular database size unless you have consulted with an Agile Solutions 
Consultant or database administrator to ensure that the computer meets the minimum 
requirements for the specified database size. 

Note If you are unable to create files, make sure that all Oracle environment variables are 
set correctly and that the 'oracle' user has full (read, write, and execute) privileges 
on all directories referenced by agile9database.sh. 

The script will run for a while. 

Note Oracle recommends that you change all Oracle database user passwords after you have 
created the Agile database. It is recommended to change these passwords periodically 
for security purposes. 

 
 

Database Post-Installation Tasks 
This section describes mandatory and optional post-installation tasks to be completed, such as 
configuring Oracle network connectivity and setting up additional Oracle functionality. 

Adding and Configuring a Listener 

If this is the first time Oracle has been installed on the current computer, you need to add and 
configure a new database listener.  

Note If you are creating a new Agile database on the same machine, you only need to add the 
new database to the existing listener. 
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To add and configure a new Listener:         

1. Start Oracle Net Manager: 

 On Windows, choose Start > All Programs > <ORACLE_HOME> > Configuration and Migration 
Tools > Net Manager. 

 On UNIX, run the command $ netmgr &. 

2. In the Oracle Net Manager window, double-click the Local folder and select the Listeners folder. 

3. Click Create  in the toolbar to add a listener. 

The Choose Listener Name dialog box appears. 

4. Click OK. 

5. In the Listening Locations drop-down list, select Database Services. 

6. Click Add Database. 

In the dialog box that appears, make the following changes: 

 Global Database Name: agile9 

 Oracle Home Directory: <ORACLE_HOME> 

 SID: agile9 

Note If you used a different global database name or different home directory during the 
database installation, change the information as appropriate. 

7. Choose File > Save Network Configuration to save your changes. 

8. Close Oracle Net Manager. 

To restart the database listener, open a Command Prompt window and type lsnrctl reload. 

Adding and Configuring a Net Service 

1. In the Oracle Net Manager window, double-click the Local folder and select the Service Naming 
folder.         

2. Click Create  in the toolbar to add a service name. 

The Net Service Name Wizard starts.    

3. In the Net Service Name field, type the name of the computer where the Oracle database is 
located (usually the current computer). Click Next.      

4. You are prompted to select a network protocol. Select TCP/IP (Internet Protocol) and click Next. 

5. Type the name of the computer where Oracle is located in the Hostname field (the same name 
you typed in step 3). Accept 1521 as the default port number. Click Next. 

6. Select Oracle8i or later as the service name, and type agile9 in the field. Click Next. 

7. Click Test to test the service. 

The test initially fails because the default uses the incorrect login.    

8. Click Change Login to reset the username and password.     
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9. Type agile in the Username field and tartan in the Password field. Click OK. 

10. Click Test. You should now see a message indicating that the test was successful.    

11. Click Close. 

12. Click Finish to exit the Net Service Name Wizard. 

13. From the Net Manager menu, choose File > Save Network Configuration to save the service name. 
 

Setting Up Automatic Shutdown and Startup for the Database on UNIX 

To set up the Oracle database to automatically shut down and start up when the host 
computer starts up and shuts down: 

1. Log in the system as root. 

2. Create a file named “dbora” in the /etc/init.d directory:  

# cat /home/oracle/agile9320db/dbora > /etc/init.d/dbora [Enter] 

3. Link to the dbora file:    

# ln -s /etc/init.d/dbora /etc/rc0.d/K10dbora  [Enter]   

# ln -s /etc/init.d/dbora /etc/rc2.d/S99dbora  [Enter]  
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Chapter 4 

Starting the Agile RMW Installer 

This chapter includes the following: 

 Installer Online Help...................................................................................................................................... 20 
 Installer Buttons ............................................................................................................................................ 20 
 Required Changes When RMW and PLM Are Installed Separately ................................................................. 20 
 RMW Post-Installation Tasks ........................................................................................................................ 21 
 Starting Recipe and Material Workspace ....................................................................................................... 21 
 Troubleshooting the Recipe and Material Workspace ..................................................................................... 22 

Important Agile PLM must be installed before installing Agile RMW. Agile RMW should not be 
installed in the same directory as Agile PLM. 

The Agile RMW installer is a Java program. The installation of all components follows the same 
initial process up through the panel where you select the components to install. 

The Agile RMW installer displays in English only, even on non-English operating systems. 

Before running the installer, make sure 

 On UNIX: You are not logged in as the root user. You should be logged in as the same user 
used to install the application server software. 

 You have enough available disk space. Refer to the Agile PLM Capacity Planning Guide for 
specific values. 

Windows: at least 1.1GB of available disk space 

UNIX: at least 1.2GB of available disk space on the drive where your default Temp directory is 
located. 

 You have disabled virus protection. 

If virus protection is enabled, components used in the installer can be falsely identified as being 
infected and lock up the installation. You can enable virus protection after the installation is 
complete. 

 You have installed the  package that includes the 32 bit library. 

To start the Agile RMW installer on Windows: 

 Log in to the computer using a login with local Administrator permissions. 

1.  In the Disk1_Windows directory, double-click the setup_win_rmw.exe file. 

Note If there is insufficient Temp disk space available to complete the installation, you will 
be prompted for another location. Click Choose, select another drive, click OK, and 
the installer will start. 

After a few moments, the Welcome screen appears. 

2.  For information about any screen in the installer, click Help. 



Installing Agile Recipe and Material Workspace  

 

 

20 Agile Product Lifecycle Management 

  

To start the Agile RMW installer on UNIX: 

1.  Log into the system. 

2.  Open a terminal window and set the DISPLAY environment variable to your X Windows 
server. 

Note The Agile RMW Installer is a graphical application and requires an X server to 
perform the installation. 

3.  Go to the directory where you copied the Agile RMW files. Locate the setup_<OS>_rmw.bin file, 
and run the program by typing the following: 

AIX: ./setup_aix_rmw.bin 
Linux: ./setup_lin_rmw.bin 
Solaris (SPARC): ./setup_sol_rmw.bin 
Solaris(X86): ./setup_solx86_rmw.bin 

After a few moments, the Welcome screen appears. 

 For information about any screen in the installer, click Help. 

Installer Online Help 
Each installation panel has online help. At any time during installation, you can click Help for more 
information about the panel's options. 

Note If you leave the online help window open, it will be updated when you proceed through 
the installer panels. Otherwise, click Close at the bottom of the help window. 

 

Installer Buttons 
Agile PLM installation panels have the following buttons: 

 Cancel -- Exits from the installation program. 

 Help -- Displays online help. 

 Previous -- Returns to the previous step. 

 Next -- Proceeds to the next step. 

 Install -- Starts installing. The Install button appears only on the Pre-Installation Summary panel, 
after you have specified installation options. 

 Done -- Exits from the installation program. On Windows, after installing certain components you 
can choose whether to restart the computer when you click Done. The Done button appears only 
on the Install Complete panel, after you have finished installing. 

 

Required Changes When RMW and PLM Are Installed 
Separately 
When PLM and RMW are installed on different servers, there are manual changes you must make 
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on the PLM side, as well as the RMW side. 

The Agile HTTP URL, RMI URL, and Web Services URL are also entered in the Agile RMW 
Installer. 

Agile HTTP URL 

Set the Agile HTTP URL: 

where "A9" refers to Agile PLM 9.x.y.z (such as 9.3.1.1). The default port number is "23791". 

Example:  

http://plm.company.com:23791/Agile  

Agile RMI URL 

If PLM is installed on WebLogic Server (WLS), the Remote Method Invocation (RMI) should be: 

Example:  

T3://plm.company.com:7001/Agile 

 

Agile Web Services URL 

Agile Web Services are located at 

Example:  

http://plm.company.com:23791/CoreService/services 

 

RMW Post-Installation Tasks 

Note You should update the AGILE_PASSWORD variable in the 
\AgilePharma\config\agile\integration.properties file. Use the encryptpwd utility, located in 
\AgilePharma\bin, to encrypt the password. 

After RMW has been installed, log in to the Java Client to enable the RMW licenses. You also need 
to provide the necessary Admin and RMW roles and privileges to navigate to RMW from Agile PLM 
and from Agile PLM to RMW. You should also verify that the File Manager is up and running. 

For detailed information on configuring Recipe and Material Workspace, see the Agile Recipe and 
Material Workspace Administrator Guide. 

Starting Recipe and Material Workspace 
Before starting Recipe and Material Workspace, you need to manually modify the agile.properties 

http://plm.company.com:23791/Agile
http://plm.company.com:23791/CoreService/services
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file in the following location on the Agile PLM application server: 
AGILE_HOME\agileDomain\config\agile.properties. 

To start Recipe and Material Workspace: 

1. Open a command prompt or terminal window. 

2. Change to the AGILE_HOME\AgilePharma\domain\bin directory. 

3. Run the startAgilePharma script. 

4. Stop the Agile PLM application server. 

5. Delete the deployed configuration folder, located at AGILE_HOME\AgileDomain\servers, that is 
named Yourservername-AgileServer. 

6. Edit the following integration parameters in the agile.properties file, located in the 
AGILE_HOME\AgileDomain\config and 
AGILE_HOME\AgileDomain\applications\applications.ear\APP-INF directories: 

 

 

 

 

 

 

7. Save the agile.properties file and restart the Agile PLM application server. 
 

Troubleshooting the Recipe and Material Workspace 
If the application system response becomes slow, check the following: 

 Check the CPU and memory usage of the process at that point in time. On UNIX systems, use 
the prstat, memstat, and mpstat commands. 

 Use the WebLogic console to check the queue length on the performance monitor tab. 

 Check the memory utilization on the WebLogic server on the performance monitor tab. 

 Check the CPU and memory usage of the database process (Oracle processes) at the son the 
database server. 

 Check the network to see if connectivity between the application server, the database, and the 
web server is established. 
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